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1.0 About This User Manual
The purpose of this manual is to help users successfully use the features that are common to all V100+ Units.

This manual is intended for novice, intermediate, and experienced users. It is assumed that users have basic computer
experience and skills, and are familiar with basic telecommunication concepts, terminology, and safety. For more technical
resources, visit VeEX Inc. website at www.veexinc.com.

Every effort was made to ensure that the information contained in this manual is accurate. However, information is subject to
change without notice. We accept no responsibility for any errors or omissions. In case of discrepancy, the web version takes
precedence over any printed literature.

© Copyright 2013 VeEX Inc. All rights reserved. VeEX is a registered trademarks of VeEX Inc and/or its affiliates in the USA and
certain other countries. All trademarks or registered trademarks are the property of their respective companies.

No part of this document may be reproduced or transmitted electronically or otherwise without written permission from VeEX Inc.

This device uses software either developed by VeEX Inc or licensed by VeEX Inc from third parties. The software is confidential
and proprietary of VeEX Inc. The software is protected by copyright and contains trade secrets of VeEX Inc or VeEX's licensors.
The purchaser of this device agrees that it has received a license solely to use the software as embedded in the device, and the
purchaser is prohibited from copying, reverse engineering, decompiling, or disassembling the software.

If any assistance is needed or there are any questions related to the use of this product, call or e-mail our Customer Care
department for customer support. Before contacting our Customer Care department, have the serial number ready. Please refer
to the Basic Operations section of this manual for details on locating the unit serial number.

Customer Care:

Phone: +1 510 651 0500

E-mail: customercare@veexinc.com

Website: www.veexinc.com

Go back to top Go back to TOC
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10.0 Warranty and Software
Warranty Period: The warranty period for hardware, software and firmware is three (3) years from the date of shipment to the
customer. The warranty period for battery pack, LCD, LCD touch panel, LCD protective cover, and accessories (including but not
limited to patch cords, AC adaptor, SFP, USB adaptors, carrying case, carrying pouch) is limited to one (1) year.

Hardware Coverage: VeEX Inc. warrants hardware products against defects in materials and workmanship. During the warranty
period, VeEX will, at its sole discretion, either

Repair the products
Replace hardware which proves to be defective

provided that the products that the customer elects to replace is returned to VeEX Inc. by the customer along with proof of
purchase within thirty (30) days of the request by the customer, freight prepaid.

Software Coverage: VeEX Inc. warrants software and firmware materials against defects in materials and workmanship. During
the warranty period, VeEX will, at its sole discretion, either

Repair the products
Replace the software and/or firmware which prove to be defective

provided that the products that the customer elects to replace is returned to VeEX Inc. by the customer along with proof of
purchase within thirty (30) days of the request by the customer, freight prepaid.

Additionally, during the warranty period, VeEX Inc. will provide, without charge to the customer, all fixes, patches and
enhancements to the purchased software, firmware and software options. VeEX Inc. does not warrant that all software or
firmware defects will be corrected. New enhancements attached to a software option require the option to be purchased (at the
time of order or the time of upgrade) in order to benefit from such enhancements.

Limitations: The warranty is only for the benefit of the customer and not for the benefit of any subsequent purchaser or licensee
of any merchandise (hardware, software, firmware and/or accessories).

Revoking the warranty: VeEX Inc. does not guarantee or warrant that the operation of the hardware, software or firmware will
be uninterrupted or error-free. The warranty will not apply in any of the following cases:

Improper or inadequate maintenance by the customer
Damage due to software installed by the customer on the unit without prior authorization (written) from VeEX Inc.
Unauthorized alteration or misuse
Damage occurred from operating the unit from outside of the environmental specifications for the product
Improper installation by the customer

Go back to top Go back to TOC
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11.0 Certification and Declarations

What is CE?

The CE marking is a mandatory European marking for certain product groups to
indicate conformity with the essential health and safety requirements set out in
European Directives. To permit the use of a CE mark on a product, proof that the
item meets the relevant requirements must be documented.

For a copy of the CE Declaration of Conformity relating to VeEX products,
please contact VeEX customer service.

What is RoHS?

RoHS is the acronym for Restriction of Hazardous Substances. Also known as
Directive 2002/95/EC, it originated in the European Union and restricts the use of
specific hazardous materials found in electrical and electronic products. All
applicable products imported into the EU market after July 1, 2006 must pass
RoHS compliance.

Click here for ROHS Statement relating to VeEX products
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12.0 About VeEX
VeEX (Verification EXperts), is an innovative designer and manufacturer of test and measurement solutions addressing numerous
technologies. Global presence through a worldwide distribution channel provides uncompromised product and technical support.

Visit us online at www.veexinc.com for latest updates and additional documentation.

Corporate Headquarters

VeEX Incorporated
2827 Lakeview Court
Fremont, CA 94538 CA
USA

Tel: +1 510 651 0500
Fax: +1 510 651 0505

Customer Care

Phone: + 1 510 651 0500
E-mail: customercare@veexinc.com
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2.0 Introduction to V100+
V100+ Chassis are high performance, robust, handheld field test platform units featuring:

Color touch-screen (easily visible even in direct sunlight)
High Capacity Li-Ion battery pack
USB, 10/100T on base chassis
Fast and easy test result transfer via:

USB memory stick
FTP upload capability

ReVeal PC software
Advanced Triple Play support: NetWiz, VoIP, IPTV, WiFi Wiz
Rugged and field-proof (1.5m drop tested)
Lightweight (less than 1kg)

The following units are currently with V100+ chassis:

MX100+
MX100e+
MX120+
MX120e+
TX130M+
TX130
CX150+/CX150-D3+
CX180+/CX180-D3+
CX120+
CX110+
CX100+

Go back to top Go back to TOC
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3.0 Safety Information

Safety precautions should be observed during all phases of operation of this instrument. The instrument has been designed to
ensure safe operation however please observe all safety markings and instructions. Do not operate the instrument in the
presence of flammable gases or fumes or any other combustible environment. VeEX Inc. assumes no liability for the customer's
failure to comply with safety precautions and requirements.

Go back to top Go back to TOC
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4.0 Home Menu

This menu can be reached at anytime during operation by pressing the home key , accessible on the rubber keypad.

Home Menu

From the VePAL Home menu (above is an example of the MX100+ home menu), the upper part of the menu contains items
specific to the test application of the handheld test set, while the lower part of the menu contains items common to most VeEX
VePAL handheld test sets:

Additional Tests
Settings
Files
Help
Backlight
Tools

Go back to top Go back to TOC
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5.0 Tools
The Tools function group is for functions available on the Management port (the Ethernet RJ-45 connector located on the right
side of the test set) and another temporary port established through a wireless device installed at the USB port of the test set.

Tools Main Menu

Select one of the application functions to enter.

Tools Hierarchy Diagram

IP Tools
Net Wiz
WiFi Wiz
Cloning
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ReVeal EZ Connect
Signature Pad
Data Card / GPS

Go back to top Go back to TOC
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5.1.1 Setup

The test port and the associated network parameters must be configured properly prior to performing any connection dependent
measurements or applications.

The Setup menu:

Network: Select connection type:
PPPoE
Ethernet
BT Dial-up
BT PAN
Data Card
WiFi

Port: Select associated network port

Status: Check the status of the network connection under the Status tab next to Setup.

Go back to top Go back to TOC

5.1.1.1 Port

Enter the configuration parameters for the test port or management port used for the IP tests.

Auto-Neg: On or Off. Matches the test set's negotiation settings to those of the link partner. If Auto-Neg is Off, the user
will need to specify Speed and Duplex parameters.

Speed: Only available when auto-negotiation is off. Select from 10Mbps, 100Mbps, or 1000Mbps when the
10/100/1000T port is selected. 1000Mbps/1Gbps is fixed when the 1000Base-X port is selected, if applicable. 
Note: In MX100e+/MX120e+, TX130M+ when auto-negotiation is off only 10Mbps and 100Mbps are available for
selection.
Duplex: Only available when auto-negotiation is off for the 10/100T port. Select from half or full duplex modes.

Flow Control: On or Off.
When flow control is enabled, the test set responds to pause frames received by the link partner by adjusting the
transmit rate.
When flow control is disabled, the test set ignores all incoming pause frames from the link partner and continues
transmitting at the configured transmit rate.

MAC: Default or Manual. If Manual is selected, the user must input a MAC address via the alphanumeric keyboard. If
Default is selected, the unit will use the unique MAC address assigned to the test set.

Port Setup

Once the parameters are configured, press Connect to establish an IP connection.
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5.1.1.2 Network Setup

To access the network connection options, tap on the Network tab on the Setup screen and select the desired setting via the
Mode drop-down menu.

Note: An IP connection and address needs to be established prior to proceeding with Ping, Trace Route, Web/FTP, ARP Wiz,
VoIP, and IPTV.

Ethernet connection for the IP Tools is done through Ethernet test port or the Management port on the right side of the unit.

Go back to top Go back to TOC

PPPoE Setup

Use this mode to connect in point to point protocol over Ethernet.

Select PPPoE from the drop-down menu next to Mode to display the PPPoE setup parameters

Profile: Default, Delete, Save, or Save As...
Mode: PPPoE (selected from the drop-down menu on the default screen)
Authentication: PAP, CHAP, or CHAP & PAP
VLAN: Off, 1 Tag or 2 Tags. For each VLAN tag, enter the following:

ID: VLAN ID. Enter value 0 to 4095.
Pri: VLAN priority 0 to 7.
Type: Set to 8100. Indicates 802.1q tag type.

PPPoE Setup (Page 1) PPPoE Setup - VLAN - (Page2 )

VLAN Setup
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Ethernet Setup (Static or DHCP)

Depending on IP Type configuration, additional fields may be required:

Profile: Default, Delete, Save, or Save As...
Mode: Select Ethernet from the drop-down menu.
DNS: Off, Manual, or Auto. If Manual is selected, a DNS IP is required in order to use the URL as a destination. Enter the
IP address of the Domain Name System (DNS) Server providing domain name translation to IP addresses.
VLAN: Off, 1 Tag or 2 Tags. For each VLAN tag, enter the following:

ID: VLAN ID. Enter value 0 to 4095.
Pri: VLAN priority 0 to 7.
Type: Set to 8100. Indicates 802.1q tag type.

DHCP Options: DHCP options can be edited. The fields can be useful in IPTV to set Top Box emulation modes. Off, All,
Vendor Type, User Class, Host Name, and Vendor Info.
Note: DHCP Options are only available under AUTO or DHCP.

Go back to top Go back to TOC

For IPv4 type configuration, the following fields are required:

IP Type - Select IPv4 from the drop-down menu.
IP Address - Select from Static or DHCP.

Static - The user is required to enter a Local IP, Gateway address, and Subnet. All Static fields can be filled by
tapping on the section to access an alphanumeric keyboard.

Local IP - IPv4 address of the test set.
Subnet - Enter the subnet mask
Gateway - IPv4 address of the network gateway.

DHCP - The test set will attempt to obtain an IP address from a DHCP server in the network where the test set is
connected

Ethernet Setup for IPv4 Static IP (Page 1) Ethernet Setup for IPv4 Static IP (Page 2)
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Ethernet Setup for IPv4 DHCP 
(Page 3)
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For IPv6 type configuration, the following fields are required:

IP Type - Select IPv6 from the drop-down menu.
IP Address - Select from Static or AUTO.

Static - The user is required to enter a Local IP, Gateway address, and CIDR. All Static fields can be filled by
tapping on the section to access an alphanumeric keyboard.

Local IP - IPv6 address of the test set.
CIDR - Classless Inter-domain Routing Network
Gateway - IPv6 address of the network gateway.

AUTO - In AUTO mode, the test set will obtain an IPv6 address using stateless autoconfiguration.

Ethernet Setup for IPv6 Static IP (Page 1) Ethernet Setup for IPv6 Static IP (Page 2)
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Ethernet Setup for IPv6 AUTO (Page 1) Ethernet Setup for IPv6 AUTO 
(Page 2)

Ethernet Setup for IPv6 AUTO 
(Page 3)
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If the test set fails to connect:

Ensure that the Ethernet cable is connected properly before trying to reconnect
Check the status LED on the Ethernet connector (on the right side of the unit) to look for port and network activity

Go back to top Go back to TOC

BT Dial-up Setup

Use this function to connect to the internet via your wireless phone. Note that your carrier's plan must support this function. A
Bluetooth device must be paired with your phone for this setup. Please refer to section 6.2 Bluetooth for further details.

Profile - Default, Delete, Save, or Save As...
Mode - Select BT Dial-up from the drop-down menu.
Service Provider - AT&T, Verizon, T-Mobile, O2, TRUE, Sprint, and Custom.
Note: Sprint is currently not supported.
APN - Enter the Access Point Name used to your wireless carrier. If it is not known, contact your carrier's customer
support
IP Type - Preselected as IPv4.
IP Address - Preselected as DHCP.
DNS - Set as Auto.

BT Dial-up Setup
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BT Pan Setup

Use this function to connect your test set to a Bluetooth Personal Area Network. A Bluetooth device must be paired with your
phone for this setup. Please refer to section 6.2 Bluetooth for further details.

Profile - Default, Delete, Save, or Save As...
Mode - Select BT Pan from the drop-down menu.
IP Type - Set as IPv4.
IP Address - Set as DHCP.
DNS - Set as Auto.

BT Pan Setup
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Data Card Setup

Use this function to connect your test set to the network using a data card.
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The Data Card network connection setup procedure is the same as the BT Dial-up setup. Please refer to the BT Dial-up Setup
section for further configuration instructions.

Data Card Setup
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WiFi Setup

Use this function to connect your test set to a WiFi network. It requires a VeEX provided USB WiFi adapter.

Before proceeding with this section make sure that the test set is connected to an Access Point (AP). Setup Procedure for this
can be found in 5.3 WiFi Wiz.

After connecting to an AP, follow the instructions for the Ethernet connection setup, found in the Ethernet Setup section for
further configuration instructions.

WiFi Setup (Page 1) WiFi Setup - VLAN (Page 2)

WiFI Setup - DHCP Options (Page 3)
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5.1.1.3 IP Connection Status (DHCP)

Ensure the Status is PASS before continuing with any IP tests.
If the connection fails, go back to the setup screen to verify that the parameters are entered correctly.
DHCP - PASS indicates that an IP address has successfully been assigned.
IP - PASS indicates that the IP address assigned has been verified to be unique in the network.
Gateway - PASS indicates that the gateway IP address is valid.
DNS - PASS indicates that the DNS IP address is valid.

IP Connection Status

Go back to top Go back to TOC
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5.1.2 Ping

PING is a popular computer network tool used to test whether a particular host is reachable across an IP network. A Ping is
performed by sending an ICMP (Internet Control Message Protocol) echo request to the target host and expects and ICMP echo
reply. The Ping Result provides the number of Sent, Received, Unreach, Missing, and the Round Trip delay.

Ping Setup

The following parameters need to be setup for the Ping test:

Address type: IP address or URL
Destination: Enter the destination IP address or URL to Ping. New destinations can be stored by selecting "Add new
address" from the drop-down menu.
Number of Pings: Press the field and use the alphanumeric keyboard to enter the number of Ping attempts (up to 10000)
that will be performed to reach the network device.
Length: Use the alphanumeric keyboard to enter the size of the ICMP ping packet that will be sent to the network device
to be detected.
Ping/Sec: Use the alphanumeric keyboard to enter the Ping repetition rate (Ping/second).
Time Out: Time-to-live (TTL) in milliseconds. Use the alphanumeric keyboard to enter the maximum time allowed (in ms,
up to 99999ms) between an ICMP ping and echo response.

Press Ping at the bottom of the screen to start the Ping test. The Ping Results screen will open.

Ping Setup
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Ping Results

The results displayed will have the following fields:

Destination: Indicates the destination IP address
Ping status: In Progress, PASS, or FAIL
Sent, Received, Unreach, Missing: Number of pings sent, received, unreached or missing. A Ping is counted missing if
no response is received before timeout. A Ping is counted unreached if an echo response is received with destination
unreachable set.
Round Trip in milliseconds:

Current: The current time for a Ping request to be answered.
Average: The average time recorded for a Ping request to be answered.
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Max: The maximum time recorded for a Ping request to be answered.
Min: The minimum time recorded for a Ping request to be answered.

Ping Results
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5.1.3 Trace Route

Trace Route is a common method used to find the route to the destination IP address or URL. It is often used to identify routing
problems and unreachable destinations. All the remote IP addresses and their response times are displayed, indicating possible
network congestion points.

Setup:

Enter the IP address or URL of the destination to be detected in the Destination box.
New destinations can be stored by selecting "Add new address" from the drop-down menu.

Press Trace to start the trace route test.

Results:

Hop: Order of the routers on the route
TTL: Time to reach each router on the route
Address: Address of each router on the route

Note: If there is no response from a particular hop, an asterisk will be displayed.

Trace Route Setup Trace Route Test Results
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5.1.4 Web/FTP

FTP Testing
Web Testing

Web Test
Web Browser

Go back to top Go back to TOC

5.1.4.1 FTP Testing

The File Transfer Protocol is used to verify the actual throughput of upstream or downstream data rate by sending or receiving
files of known size. The FTP function displays server login time including the speed at which a download or an upload is
occurring (during the transfer or once the transfer is complete). The FTP transfer speed is accurate to within 80 to 90% of the
true total throughput attained because the displayed rate does not consider the IP and transport overhead. For FTP download or
upload, configure the following Setup Options.

Go back to top Go back to TOC

Setup

Profile: Recall a FTP profile or create a new FTP test session. Pull-down selections are Default, Delete, Save, Save As...
Mode: Select between FTP or Web mode.

FTP Mode: Displayed when FTP is selected. Select either Upload or Download to upload a file to an FTP server or
download a file from an FTP server.

File/Path: Enter any file path using the alphanumeric keyboard, if applicable.
Username: Enter user name needed to login into server using the alphanumeric keyboard.
Password: Enter password needed to login and authenticate access to the FTP server.
(Upload Mode only) Size: Set the file size (up to 1024MB) to be transmitted in MB or KB.

Web Mode: Select Test or Browser. For more information about Web Testing, see Web Testing and Web Browser.
Address: Enter IP address of the FTP server using the alphanumeric keyboard.

Press Start to initiate the download or upload process.

FTP Mode Setup

Results

The FTP Upload or Download Result screen indicates:
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Status - PASS or FAIL.
Server Rx to Login - Time taken for receiver to login.
Data Transfer - Total data transferred (in kB).
Total Transfer Time - Total time to upload or download data (in ms).
Average Throughput - Average data transfer rate (in KB/s).

FTP Results
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5.1.4.2 Web Testing and Web Browser

Web Test is used to verify that the internet is properly provisioned at the service point.

Web Mode can be set to either:

Web Test: Measures the web access
Web Browser: Allows browsing any web page from the test set
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Web Test Setup

To perform a Web Test, setup the following configurations:

Profile: Recall a known profile or enter the desired IP address or URL destination. Pull-down selections are Default,
Delete, Save, Save As...
Mode: Select Web Mode from the drop down list
WEB Mode: Select Test from the drop down list
Address: Enter the URL or IP address using the alphanumeric keyboard.
Repeat: Set the number of repetitions
Press Start

Results

The following results are displayed in current, average, minimum and maximum:

Status - PASS/FAIL indication of HTTP traffic.
Response Time - Time taken for device to respond (in ms).
Transfer Time - Total time to upload or download web page content (in ms).
Data Transfer - Total data transferred (in KB).
Average Throughput - Average data transfer rate (in MB/s).
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Web Test Setup Web Test Results
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Web Browser Setup

Mode - Select WEB from the drop-down menu.
WEB Mode - Select Browser from the drop-down menu.
Address - Enter the URL or IP address using the alphanumeric keyboard.
Encoding - Select website character encoding. Available in English, Chinese, Russian-CP1251 and Russian-UTF8.
Enter or select the desired IP address or URL destination, and encoding, and then press Start.

Result

The screen will turn blank while launching the spider web browser engine.
The web page is divided into quadrants. Use the slide bars to navigate up/down and left/right.
It is possible to navigate links within the screen.
To edit the website address, tap on the search box to access a soft keyboard and enter text. To bookmark webpages, tap
on the bookmark icon.
Click the close button in the Top right hand corner to exit.

Note: If a DNS server is not detected, an error message will display.

Web Browser Setup Web Browser Mode
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Web Browser URL Web Browser Bookmarks
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5.1.5 ARP Wiz

ARP Wiz uses the Address Resolution Protocol (ARP) to verify the status of each IP address in a user-selectable IP range. ARP
is the standard method for finding a host's hardware address when only its network layer address is known. In other words, ARP
is used primarily to translate IP addresses to Ethernet MAC addresses. ARP is defined in RFC826.

Setup

Configure the following parameters:

IP Start Address: Starting IP Address
IP End Address: Ending IP Address
Note: Subnet is not a configurable option

Then press Start.

Result

The MAC addresses associated with active IP addresses in the range are displayed. If no MAC address is associated with the IP
address, a "FAILED" status is displayed.

Note: ARP Wiz uses the ARP protocol and can only work within the same subnet as the IP address provided to the test set in IP
Status.

ARP Wiz Setup ARP Wiz Result
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5.1.6 VoIP

VoIP Expert Overview
VoIP Expert Setup
Server Status
Client Status
VoIP Expert Results

MOS/R
Packets
Events

VX1000 Server
VoIPCheck
IP Phone

Setup
H.323
SIP

Status
Placing a Call
Receiving a Call
Trace
DTMF
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5.1.6.1 VoIP Expert

Overview

VoIP Expert is a simple and effective tool for pre-qualifying VoIP service and verifying triple play implementations. It allows the
user to assess end-to-end VoIP QOS under simulated or live network conditions where packet loss, latency, jitter, bandwidth
congestion, link disconnects, IP version type, VLAN and MPLS routing and concurrent triple play traffic all play a role.

The Client/Server mode allows a pair of VePAL 100+/300 series test sets or a test set connected to a VX1000 server to
exchange upstream and downstream files to exercise the connection under VoIP calls conditions. Bidirectional Mean-Opinion-
Score (MOS), Transmission-Rating-Factor (R-factor) and other critical network related parameters are measured. Test results are
displayed on both field test units and the VX1000 software and can be saved and retrieved for future reference and
benchmarking.
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VoIP Expert Setup

Select the VoIP tab to proceed with VoIP Expert setup. The following options are available under Mode:

Client: Simulates a VoIP call between two sets or one test set and a server, and mesures the VoIP quality parameters
Server: Type in the destination server address.
Encoding: Select the codec from the pull-down menu. The voice file transmitted will use the selected encoding.
Supported codecs are G.711 A-law, G.711 μ-Law, G.729 (optional), G.723. (optional)
Test Duration: Configures the duration of the voice test file.
Jitter Buffer: Enter the size in ms of the jitter buffer. Packets received after this duration, will be discarded and
negatively impact the quality scores. This setting emulates the jitter buffer configured in the IP phones.

Server: Simulates a VoIP call between two sets or one test set and a server, and measures the VoIP quality parameters
IP Phone: IP Phone mode emulates an IP phone (see section 5.1.6.4 IP Phone)
VoIPCheck: VoIPCheck allows testing the network readiness for VoIP without placing an active VoIP call (see section
5.1.6.3 VoIPCheck)

Press Start to start the VoIP test in Client or Server mode.

VoIP Expert - Client Setup VoIP Expert - Server Setup
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Status

Status tab indicates:

ST: Start Time
ET: Elapsed Time
Test progress

Server Status:

There are four stages in Server test mode:

Wait for Client or Server: Wait for the Client to connect with the server or vice versa.
Connecting: Once client is connected to the server, the downstream test will be performed.
Downstream: As soon as the downstream is completed the upstream test will be performed.
Upstream: As soon as the upstream is completed, a Pass or Fail result will be indicated.
File Pass: File Pass will be displayed when the test file completes transmission.
Measuring Done: Measuring Done will be displayed when the voice quality measurements are completed

VoIP Expert Status - Server Mode
File Transfer Downstream

VoIP Expert Status - Server Mode
File Transfer Upstream

V100+ Common Functions e_Manual D07-00-010P RevC00 Page 32 of 103



Go back to top Go back to TOC

Client Status:

There are three stages in Client mode:

Upstream - Stream the voice file to the Server
Downstream - Once the upstream is completed the downstream test will be performed
VOIP Test Complete - VOIP Test Complete will be displayed when the test is completed

VoIP Expert Client Status Connection VoIP Expert Client Status
Test Complete
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VoIP Expert Results

Test results for all VoIP tests are found under the status tab.

Voice Quality measurements are displayed for both directions.

Upstream results (UP) = Outgoing stream
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Downstream results (DN) = Incoming stream

MOS/R

The Mean Opinion Score (MOS) and R-factor measurements are performed by a Telchemy™ VQmon® VoIP quality
measurement engine, which is integrated into the test set. The VQmon/SA feature supports:

Listening and conversational quality metrics
MOS scores and R factors
Detailed packet/RTP statistics
Jitter buffer emulation

VoIP MOS Ratings

VoIP MOS and R-Factor Ratings

UP: Indicates that the results are for the upstream direction: Transmitted packets.
DN: Indicates that the results are for the Downstream direction: Received packets. Note that Client and Server results will
show with reversed measurements.
MOS-LQ: Listening Quality MOS score, this score is based on packet metrics: codec, packet loss, discard and jitter. Per
ITU-T G.107 converted on a MOS scale.
MOS-CQ: Conversational Quality MOS score, this score is based on listening quality metrics and also includes network
delay. Per ITU-T G.107 converted on a MOS scale.
R-LQ: Listening Quality R factor, this score is based on packet metrics: codec, packet loss, discard and jitter. Per ITU-T
G.107.
R-CQ: Conversational Quality R factor, this score is based on listening quality metrics and also includes network delay.
Per ITU-T G.107.
Gap R: Conversational Quality R factor during Gap period. A Gap is a period of no loss or low loss density.
Burst R: Conversational Quality R factor during Burst period. A Burst is a period of high packet loss or packet discard
density (> 5%).

VoIP Status Screen VoIP - MOS/R Results
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Packets

Statistics (Page 1)

Throughput - Average Data rate in kbps
Loss Rate - Average Packet Loss rate in kbps. A lost packet is never received by the application.
Discard Rate - Average Packet Discard rate in kbps. A discarded packet is received, but too late, and thus discarded by
the jitter buffer.
Burst Loss Rate - Average percentage of packets lost or discarded during a Burst condition. A Burst condition is a period
of high loss density (over 5%)
Burst Length - Average Burst Length in ms
Gap Loss Rate - Average percentage of packets lost or discarded during a Gap condition. A Gap condition is a period of
no loss or low loss density.
Gap Length - Average Gap Length in ms

Packet Statistics (Page 1) Packet Statistics (Page 2) 
(Page 2)
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Statistics (Page 2)

OOS Packets - Number of packets received out-of-sequence
Duplicate Packets - Number of duplicate packets received
PPDV Jitter - The packet-to-packet delay variation in milliseconds as defined in RFC 3550. The interarrival jitter is defined
to be the mean deviation of the difference in packet spacing at the receiver compared to the sender for a pair of packets.
If Si is the timestamp from packet i, and Ri is the time of arrival for packet i, then for two packets i and j, D(i,j) = (Rj - Ri)
(Sj - Si). The interarrival jitter is calculated continuously as each data packet i is received from source according to the
formula J(i) = J(i-1) + (|D(i-1,i)| - J(i-1))/16
MAPDV Jitter - The true average mean-absolute packet delay variation in milliseconds. Per ITU-T G.1020. If the nominal
arrival time (denoted below ai) for a packet is known or can be determined then the absolute delay variation is abs(ti - ai).
The mean absolute packet delay variation is therefore: MAPDV = mean( abs(ti - ai) )
Average PDV - The running average mean-absolute packet delay variation in milliseconds. This average takes the
difference of the average positive and average negative envelopes. Per ITU-T G.1020.

Mean delay: Di = (15*Di-1 + ti-1) / 16
Positive deviation: Pi = ti - Di, (if ti > Di)
Negative deviation: Ni = Di - ti, (if ti < Di)
MAPDV2 = mean( Pi )+ mean(Ni )

Maximum PDV - The maximum of the average mean-absolute packet delay variation in milliseconds.
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Events

The Events tab indicates a time stamped log of the various test steps with Pass/Fail criteria.

VoIP - Events Tab
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5.1.6.2 VoIP Expert VX1000 Software Setup

The VX1000 software is a stand alone software sold separately. The software runs on a Windows based PC. It can be installed
on any server and accepts up to 16 simultaneous VoIP test calls from compatible VePAL 100+/300 series products.

Press Start to begin the test. The test set will wait for Client to initiate connection.

My IP: Automatically detects the IP address of the Ethernet LAN card
Currently: Running or Stopped. Indicates VX1000 status.
Setup:

Mode: Select Server from the pull-down menu
Result file path: Select the path where results files will be stored.

Threshold: Configure pass/fail thresholds on voice quality measurements (R-MOS)
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Note: Results are automatically saved when the test is completed. 

Note*: If the server is running on a V100+/V300 series unit, only 1 Client connection can be active. If the server is
running on a VX1000 server, up to 16 connections can be active simultaneously.

VoIP Expert VX1000
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VX1000 VoIP Expert Results

VX1000 displays the list of available test results.

It automatically stores the results for all the client connections.

VX1000 VoIP Expert Results
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Select the result(s) you would like to view by clicking the corresponding check box.

Click the View button to display the selected result(s).

MOS/R Results

Quality Metrics Results
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UP: Indicates that the results are for the upstream direction: Transmitted packets
DN: Indicates that the results are for the Downstream direction: Received packets.
Note that Client and Server results will show with reversed measurements
MOS-LQ: Listening Quality MOS score, this score is based on packet metrics :codec, packet loss, discard and jitter. Per
ITU-T G.107 converted on a MOS scale
MOS-CQ: Conversational Quality MOS score, this score is based on listening quality metrics and also includes network
delay. Per ITU-T G.107 converted on a MOS scale.
R-LQ: Listening Quality R factor, this score is based on packet metrics: codec, packet loss, discard and jitter. Per ITU-T
G.107
R-CQ: Conversational Quality R factor, this score is based on listening quality metrics and also includes network delay.
Per
ITU-T G.107
Gap R: Conversational Quality R factor during Gap period. A Gap is a period of no loss or low loss density.
Burst R: Conversational Quality R factor during Burst period. A Burst is a period of high packet loss or packet discard
density (> 5%).
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Jitter Buffer Statistics

Jitter Buffer Statistics
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Packets Lost: Number of packets not received
Packets Discarded: Number of packets received too late that have been dropped by the jitter buffer
Packets Early: Number of voice stream packets arriving early, but still within the jitter buffer range
Packets Late: Number of voice stream packets arriving late, but still within the jitter buffer range
Packets out-of-order: Number of voice stream packets that arrive out of sequence, as detected by the jitter buffer
Packets duplicated: Number of duplicate voice stream packets discarded by the jitter buffer
Underrun discards: Number of voice stream packets discarded by the jitter buffer due to the late arrival (exceeds the
configured jitter buffer depth)
Overrun discards: Number of voice stream packets discarded by the jitter buffer because the jitter buffer is already full.
Delay increases: Number of adaptive jitter buffer emulator delay increases
Delay decreases: Number of adaptive jitter buffer emulator delay decreases
Re sync count: Number of jitter buffer emulator resynchronizations due to DTX/VAD/silence suppression
Reset count: Number of jitter buffer emulator resets due to complex error occurrence. For example, if the jitter buffer
emulator is unable to properly resynchronize to the incoming packet stream, a reset is performed.
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MOS/R

Degradation Factors
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Loss Degradation: The percentage of the overall quality degradation that can be attributed to network packet loss.
Discard Degradation: The percentage of the overall quality degradation that can be attributed to jitter buffer discard (i.e.
jitter)
Codec Degradation: The percentage of the overall quality of degradation that can be attributed to codec.
Delay Degradation: The percentage of the overall quality of degradation that can be attributed to delay.
Recency Degradation: The percentage of the overall quality degradation that can be attributed to loss or discard
recency.

Burst and Gap Metrics
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Burst/Gap Count: Number of bursts that occur on the voice stream
Avg Burst/Gap Loss rate: The average percentage of MIUs lost and/or discarded during burst conditions.
Avg Burst/Gap Length (ms): The average burst length in ms.
Avg Burst/Gap Length (pkts): The average burst length in packets.
Burst/Gap R: The average listening R-factor for the gap periods.
Avg. Loss Rate: The total average percentage of MIUs lost and/or discarded.
Avg. Net Loss Rate: The total average percentage of MIUs lost in the network.
Avg. Discard Rate: The total average percentage of MIUs discarded.
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Packet Statistics

Delay Metrics
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PPDV Jitter: The packet-to-packet delay variation in milliseconds as defined in RFC 3550. The interarrival jitter is defined
to be the mean deviation of the difference in packet spacing at the receiver compared to the sender for a pair of packets.
If Si is the timestamp from packet i, and Ri is the time of arrival for packet i, then for two packets i and j, D(i,j) = (Rj - Ri) -
(Sj - Si).
The interarrival jitter is calculated continuously as each data packet i is received from source according to the formula J(i)
= J(i-1) + (|D(i-1,i)| - J(i-1))/16
MAPDV Jitter: The true average mean-absolute packet delay variation in milliseconds. Per ITU-T G.1020.
If the nominal arrival time (denoted below ai) for a packet is known or can be determined then the absolute delay variation
is abs(ti - ai).
The mean absolute packet delay variation is therefore: MAPDV = mean( abs(ti - ai) )
Average PDV: The running average mean-absolute packet delay variation in milliseconds. This average takes the
difference of the average positive and average negative envelopes. Per ITU-T G.1020.

Mean delay: Di = (15*Di-1 + ti-1) / 16
Positive deviation: Pi = ti - Di, (if ti > Di)
Negative deviation: Ni = Di - ti, (if ti < Di)
MAPDV2 = mean( Pi )+ mean(Ni )

Max PDV: The maximum of the average mean-absolute packet delay variation in milliseconds >
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5.1.6.3 VoIP Check

VoIP check allows testing the network readiness for VoIP without placing an active VoIP call. This mode allows for service
verification before SIP/H.323 infrastructure is in place or if credentials are not known. This test focuses on packet transmission
quality and metrics by sending traffic (ICMP Ping) mimicking a VoIP call. ICMP Ping payload will be sent with a content, rate and
size similar to the selected codec.
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VoIP Check Setup

Select VoIPCheck from the Mode drop-down menu and fill out the following parameters:

Server: Type destination server (the ICMP ping will be sent to this address). Make sure that the destination address is
representative of the VoIP calls. For example, use SIP Proxy address or destination SIP phone. Make sure that ICMP Ping
Requests are not blocked by the network.
Encoding: Select codec: the ICMP ping will be sent with a payload content and size similar to the selected codec.
Supported codecs are G.711 A-law, G.711 μ-Law, G.729 (optional), G.723.1 (optional)
Jitter Buffer - Enter the size in ms of the jitter buffer. This value is used to emulate a jitter buffer on the received traffic.
ICMP Ping Replies received after this duration, will be discarded and negatively impact the quality scores.

Press start to begin the test. "VOIP Test Complete" will display on the status screen upon completion.

Note: Trace and DTMF functions are not accessible in VoIP Check mode.

VoIP Check Setup VoIP Test - Status Screen

Test Results
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For more information on VoIP Check test results, please see the previous section, VoIP Expert Test Results.
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5.1.6.3 VoIP Call Expert - IP Phone

IP Phone mode emulates an IP phone and can place and receive calls using SIP or H.323 protocols, sending or receiving live
audio (with headset) or prerecorded files over a network.

Call Setup with H.323

Call Setup with SIP
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VoIP IP Phone Setup

Select the VoIP tab to proceed with the IP Phone setup.

Profile: Recall an existing or save a new profile.
Mode: Select IP Phone from the Mode pull-down menu.
Protocol: Select H.323 or SIP from the pull-down menu.
Codec: Select between G.711A, G.711U, G.723.1 (optional), or G.729 (optional)
Headphone: When the user turns On the headphone selection, an information box appears prompting you to plug-in the
VeEX USB headphone adaptor. Ensure the headphone USB adapter is properly connected to the test set before pressing
OK.

Note: Headphone ON is required for G.723.1 or G.729 codecs.
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For H.323 Phone Setup, fill out these additional parameters:

GK Discovery: Select Off from the pull-down menu. The IP address of the Gatekeeper must be known.
GK IP: Enter the IP address of the Gatekeeper
Port: Enter the Port number of the Gatekeeper
User: Enter user information
User Number: Endpoint Alias Dialed Digits
H.323 ID: Endpoint Alias address H323-ID
E.164 Number: The E.164 Number is already preassigned
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Note: Trace and DTMF are disabled in H.323 mode.

VoIP - H.323 Setup
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For SIP Phone Setup, fill out these parameters:

Page 1:

Registrar: On/Off. Selecting On requires the user to enter URL or IP address of the SIP Registrar
Proxy:

ON: Enter URL or IP address of SIP Proxy. SIP Invite will be sent to this address
OFF: Invite will be sent to Registrar or Outbound Proxy depending on configuration

Outbound
ON: Enter URI or IP address of SIP Outbound Proxy. All the messages will be sent to this destination IP address.
OFF: Messages will be sent to Registrar or Proxy IP address depending on configuration.

Username and Password - for registering with the call authentication server
Caller ID: Off or On. Username sent to the SIP authorization digest
Codec: Select between G.711A, G.711U, G.723.1 (optional), or G.729 (optional)

Page 2:

Headphone: On or Off
Jitter Buffer: Specifies the type of jitter buffer used by the test set receiver

Fixed: A fixed jitter buffer is used, the depth can be specified from 40 to 500 ms.
Auto: A dynamic jitter buffer is used, it dynamically adapts to the current jitter in the network

SIP Port: Port number used for SIP messages (default 5060)
RTP Port: Port number used for RTP media (default 5000)
Auto Answer: If enabled, allows the test set to automatically answer incoming calls
Session Timer: When enabled, a re-invite will be sent at the expiration of this timer per RFC 4028.
DSCP QoS: When enabled, enter the DiffServ field per RFC 2474
STUN Server: When enabled, enter the IP address of a STUN Server. STUN enables a device to find out its public IP
address and the type of NAT service it is sitting behind. If ON is selected, use the alphanumeric keyboard to enter the
STUN Server IP address.
DialStyle:

URL: Enter destination address URL
POTS: Enter destination Phone number

Number of Calls: Enter the number of simultaneous calls that will be placed to the peer. Up to 24 simultaneous calls
supported.

Page 3:
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NAT Update: On or Off
DTMF Format: RFC 2833 or DTMF Tone
Voice GW: On or Off

Press Register to start registration.
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Status

The Status screen displays the registration progress and will display "Online" once registration is completed. If the test set fails to
register, please go back to the setup screen and make sure all the parameters are entered correctly and register again.

VoIP- SIP Phone Setup (Page 1) VoIP- SIP Phone Setup (Page 2)  

VoIP Call Status - In Progress VoIP Call Status - Online

VoIP Headphone Warning
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Placing a call - If the registration is successful you can place a call to a remote party.

To place a call, use the alphanumeric keyboard to enter a destination address in the Peer URL field. The address can be
a phone number (phone number@sipserver) or alias (bob@sipserver). Press Call to start the test. The Status will display
the call progress.
When the call is connected press the MOS ON key to start voice quality measurements.
If bundle size is set to any number greater than 1, simultaneous calls will be placed to the destination. To listen or talk to
a specific call, make sure the headset is plugged in and tap on the corresponding box. Pressing Hang Up will end all
active calls.
Note: Voice quality measurements are done on the call that is selected, indicated by the blue highlighted box that displays
"Listen." To perform voice quality measurements on a different call, it is recommended to press MOS Off before selecting
the other call for more accurate results.

Pressing MOS View brings up three screens displaying packet statistics. For more information on packet statistics, please refer to
the VoIP Expert Results section.

MOS View - MOS Scores (Page 1) MOS View - Packet Statistics (Page 2)

MOS View - Packet Statistics (Page 3)
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Receiving a call - An information box will appear on the screen when there is an incoming call. The user can choose to accept
or decline the call. Once connected, the user can use the USB headphone adapter to talk and listen when the call is active, if
the adapter has been installed and the Headphone setting is set to ON during registration process.

VoIP - Incoming Call
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Trace

Pressing Trace after transmitting a call displays all captured signaling packets. Click on a packet to open a more detailed view.

VoIP - Trace Information (Page 1) VoIP - Trace Information - Detailed View
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DTMF

During the call DTMF tones can be transmitted as RFC4733 events.

To transmit DTMF tones, access the DTMF tab. An alphanumeric keypad will be displayed. DTMF tones are transmitted as soon
as they are typed.

DTMF Tab Menu
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V100+ Common Functions e_Manual D07-00-010P RevC00 Page 51 of 103



5.1.7 IPTV

Overview
Setup

Setup
Probe
Editor
Unicast Test
Monitor Test
Multicast Test
RTSP

Result
Summary
Stream
MAP

Scan
Viewer
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5.1.7.1 Overview

The IPTV function allows the user to perform IPTV testing in a Triple Play network. The feature supports:

Set Top Box (STB) emulation
IGMP/RTSP signaling, MPEG2/4, H.264 encoding, RTP/VC1/MPEG-TS transport streams
Packet Statistics: packet loss, jitter, delay, PID mapping
Line, video/audio, and total stream rates
Channel zapping for quick and complete installation check
TV channel viewer to confirm proper channel

Typical IPTV Test Application - DSL Triple Play Network

Note: If IPTV is not activated in Global Settings, a warning message will appear. For more information on accessing Global
Settings, please refer to 6.0 Settings. To activate IPTV, go to the Global Settings page, press on the Management Port field and
select IPTV/Testing from the drop-down menu. Due to resource allocation, remote control and IPTV application can't be active
simultaneously.

IPTV Warning Message Activating IPTV Settings from
Global Settings page
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5.1.7.2 IPTV Setup

The IPTV menu allows configuring the following parameters:

Setup tab: The user can setup the Table and channel streams here.

Table: Select the IPTV channel table for use in the test. The IPTV channel table can be prepared using the ReVeal
software and then uploaded to the test set.
Channel #: Select and configure the channel to be analyzed. Up to three channels or streams (Multicast or Unicast) can
be analyzed simultaneously. The channel can be in IP address or URL format.
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Probe tab: The Probe function is a packet sniffer. It detects all incoming unicast or multicast traffic to the test port and displays
the channel name and address.

The probe function is used to detect streams received by the test set. This can then be saved as a channel table.

This function can be used prior to any configuration.

Note: The probe function does not send IGMP join requests, the streams need to be already established by the STB prior to
using this function.
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Editor tab - Allows manually configuring the IPTV channel table. Depending on the Type chosen, configuration options for URL,
Port, Dir, and Control will vary. These options will be discussed later in individual Type sections. Below is the setup for
parameters that do not change regardless of Type.

Table - Use the drop-down menu to select the channel table from a defined list, create a new table or load a table
created with ReVeal PC software
Channel - Select from Add Channel, Delete Channel, Unicast Test or Multicast Test.
Type - Select a channel type from the drop-down menu.

Unicast Channel (IPv4 or IPv6) - The stream will be directed to the test set's IP address. With unicast stream, the
test set does not use IGMP.
Management Channel - For BX products only - Passthrough Monitor mode between test port and monitor port
(modem emulation).
Multicast Channel (IPv4 or IPv6) - The test set will use IGMP to join the multicast stream.
RTSP (IPv4 only) - This protocol is used to stream Video On Demand Channel.

Transport - From the drop-down menu, select the type of transport encapsulation used for the test. The following
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transport types are supported:
MPEG TS UDP - Used for transport of MPEG2 transport stream (TS) per ISO 12818-1 over UDP
MPEG TS RTP - Used for transport of MPEG2 transport stream (TS) per ISO 13818-1 over RTP
Proprietary MPEG TS - Used to monitor specific PIDs (can be used in the case of scrambled media)

Custom PID values can be entered for measurement when proprietary MPEG TS is chosen as transport
type.
Proprietary MPEG TS transport type is useful for certain IPTV streaming, such as MSTV, which may use
MPEG TS transport layer but is not fully compliant with the ISO 13838-1 recommendation.

Proprietary RTP - Payload is directly embedded in RTP without using MPEG2 TS using media profile as per RFC
2250 and RFC3016.

Codec - The codec field is auto configured. The unit will automatically detect the codec used in the stream. The video
codecs supported are: MPEG2, MPEG4-2, and MPEG4-10 (H.264).
MPEG - Select TS ISO for the 188 byte TS packet length or TS ARIB for the 192 byte frame length commonly used in
Japan.

Note: Make sure the video is already streaming before pressing Start on the Probe Tab.

MPEG Transport

Proprietary MPEG TS IPTV Setup Tab
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IPTV Probe Tab IPTV Editor

Proceed to the specific Type section (Unicast, Monitor, Multicast, RTSP) for further setup instructions.

Unicast Test
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Additional setup parameters for Unicast Test:

URL and Port: If Unicast Channel is selected, the URL is fixed to the test set IP address. The Port number can be edited
to correspond to the Destination port number of the video stream.
Dir and Control fields do not apply for unicast test.

Monitor Test
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Additional setup parameters for Monitor Test:

URL and Port: The URL and Port number can be edited to select the stream you wish to monitor
Dir and Control fields do not apply for monitor mode

Note: In monitor mode, the test set does not send IGMP or RTSP messages; it only monitors the streams requested by the STB.

Multicast Test
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Additional setup parameters for Multicast Test:

URL and Port: If Multicast Channel is selected, the URL and Port number fields can be edited to enter the Multicast
address of the channel you want to monitor
Dir field does not apply to multicast channel
Control: Select the IGMP (Internet Group Management Protocol) version number. IGMPv2 (standard RFC2236) and
IGMPv3 (standard RFC4604) are supported.
The test set emulates an IGMP client and sends and IGMP join command to join the stream.

RTSP
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Real Time Streaming Protocol (RTSP) test is used to setup, request and command video streams form network based VoD
servers.

Note: The STB middleware will provide authentication/payment information necessary for the purchase of VoD. The test set only
emulates RTSP client to request a stream and does not provide middleware functions.

Additional setup parameters for RTSP:

URL and Port: The URL can be edited to enter the IP address of the VOD server. The port number is fixed to 554 for
RTSP and can't be edited.
Dir field can be edited to enter the path directory where the video request is located.
Control is set to RTSP and can't be edited.

V100+ Common Functions e_Manual D07-00-010P RevC00 Page 57 of 103



Go back to top Go back to TOC

IPTV Result

IPTV Summary tab displays:

Status should indicate Streaming
Line rate - Rate of the test port (DSL or Ethernet)
Total stream - Total bandwidth received on the channel.
Video stream - Bandwidth of video streams received on the channel
Audio stream - Bandwidth of audio streams received on the channel
Data Stream - Bandwidth of data streams received on the channel (this includes Program Association Table [PAT] and
Program Map Table [PMT])
Other Stream - This could include rate of unknown/proprietary PID or Null packets

IPTV Stream Analysis

Up to three streams can be analyzed and the bandwidth associated with the whole TS is
displayed.
Video streams typically consume more bandwidth than audio streams, which in turn use more
bandwidth than data streams.
In this manual, MPEG-2 refers to the video transport stream defined in IEC13818 standard
and not any compression technology used in the payload or transport packet.
The MPEG-2 Transport stream contains seven packets of 188bytes each which transports
either the MPEG-2, MPEG-4 or VC-1 encoded video.
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IPTV Stream tab displays:

IPTV Stream Packets (Page 1) - Displays the following results:

Video Rx - The total number of MPEG2 TS video packets received
Video Loss - The total number of MPEG2 TS packets lost in the video stream
Audio Rx - The total number of MPEG2 TS audio packets received
Audio Loss - Total number of TS packets lost in the audio stream
Packet Rx - Total number of MPEG2 TS packets received
Min is the minimum Ethernet packet IPG (ms)
Max is the maximum Ethernet packet IPG (ms)
Avg is the average Ethernet packet IPG (ms)
Latency - Measures the latency between the start of the test and the first packet received

IPTV Stream Packets (Page 1)
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IPTV and Packet Loss

Due to the real-time nature of IPTV, the MPEG-2 TS is transported over UDP (IPv4/UDP), thus
retransmission or re-ordering of packets is not intended.
Video quality is largely determined by network performance parameters including Packet loss,
Packet jitter and IGMP latency.

IPTV Stream Rates (Page 2) - Displays the Stream Rate results:

Table provides individual bit rate statistics for each stream:
Total is the total number of bytes related to the Video, Audio and Data payloads
Video is the number of packets classified as video packets
Audio is the number of packets classified as audio packets
Data is the number of packets classified as data packets
Other is the number of packets classified as unknown packets

IPTV Stream Rates (Page 2)
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IPTV Packet Jitter (Page 3) - Displays the Packet Jitter results:

Packet Jitter displayed in milliseconds
Current is the current jitter value
Max is the maximum jitter value
Latency - The time to complete a program change measured in milliseconds (ms)

IPTV Packet Jitter (Page 3)

IPTV and Packet Jitter

Packet Jitter measurement is based on the packet inter-arrival time which is a measure
of packet arrival variance.
Packet jitter affects packet arrival throughout the entire network and variations lead to
buffer under / overflows at the receiving equipment e.g. STB.
Jitter impacts the way packets are handled at various net work elements i.e. If the jitter
is too high, packet loss will increase as queuing software tries to load balance traffic at
network elements.
Packet jitter should not be confused with PCR jitter. When Packet jitter is present, the
cause is normally related to the Ethernet physical layer.
When PCR jitter is present, then the cause is most likely related to the program flow
and could be related to an encoder not performing to specification.

IPTV Stream QoS and PCR (Page 4) - Displays the Quality of Service (QOS) results:

PCR Clock - Presence of 27MHz Program Clock Reference
PCR Jitter - PCR deviation in (ms)
Current is the current PCR deviation (ms)
Max is the maximum PCR deviation (ms)
Error Indicator - Error indicator bit set in the MPEG TS header
Latency - Measures the latency between the start of the test and the first packet received.
Video CC Err - Video TS stream continuity counter error
Audio CC Err - Audio TS stream continuity counter error

IPTV Stream QoS and PCR (Page 4)
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IPTV and Program Clock Reference (PCR)

MPEG TS usually contain a built-in timing packet known as the Program Clock Reference
(PCR).
Recovering the 27 MHz clock at the decoder end of the transmission system is necessary to
re-create the video signal.
PCR values need to be correct at the signal origin and should not be distorted along the
transmission path to a point where decoding the compressed signal becomes problematic.
Measuring the interval between the arrival of PCR values, the accuracy of the expected
values and also the jitter accumulated on those PCR values transmitted is necessary to
assure that streams can be decoded.
PCR jitter is a good indication of timing distortions due to poor encoding. Excessive PCR jitter
results in visual impairments such as frame freezes, color loss and pixelization.
The amount of PCR jitter that is considered excessive varies, and depends on various factors
including STB buffer sizes and software architecture - in today's packetized video networks,
PCR jitter should not exceed 10 ms.
If PCR jitter is not constant, then a momentary problem from inserting local programming
may be the cause.

IPTV Transport Results (Page 5) - Displays the Transport results:

MPEG Packet Loss
MPEG Packet Rx - MPEG packets received
MPEG Packet Loss (%)- Current and Maximum continuity error (%)

IPTV Transport Results (Page 5)
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IPTV MDI Results (Page 6) - Displays the Media Delivery Index (MDI) results:

MDI (Media Delivery Index) - MDI is expressed as a ratio, e.g. 70:15 (Delay Factor (ms): Media Loss Rate [packets lost])
DF (Delay Factor) - Average, Minimum and Maximum values. Also defined as cumulative IP jitter, it represents the time it
would take to drain an output buffer and ensure good video playback.
MLR (Media Loss Rate) - Average, Minimum and Maximum values. Also defined as the packet loss rate due to dropped
packets, bad/corrupted packets, or out-of-sequence packets.

IPTV MDI Results (Page 6)

Media Delivery Index (MDI)

Defined in RFC4445, MDI is the only standardized video quality metric available today.
MDI quantifies two IP transport impairments, namely Packet Jitter or Delay and Packet Loss.

These test parameters are defined as Media Delay Factor (MDI-DF) and Media Loss Rate
(MDI-MLR).

The Delay Factor (DF) indicates how long a data stream must be buffered at its
nominal bit rate to prevent packet loss. It gives a general idea of network jitter using
the DF measurement. The MDI-DF can give a measure of congestion in a network, by

V100+ Common Functions e_Manual D07-00-010P RevC00 Page 62 of 103



showing utilization level, and detect if queuing is happening in network components,
but it does not indicate how much of this is due to video packet bunching.
The Media Loss Rate (MLR) is the number of packets lost during a 1 second period.

MDI is expressed as a ratio namely;
Delay Factor : Media Loss Rate, e.g. 70:15 
The above ratio shows a delay factor of 70ms and 15 packets lost per second.

MDI and MPEG packet loss together provides a good indication of IP transmission and non
related IP issues.

Go back to top Go back to TOC

IPTV Result MAP:

The MAP table provides a summary of the stream composition and the programming present.

Str - Indicates stream number
PID - Packet Identifier is a unique channel address identifier.

PID enables identification and reconstruction of the programme and is used in conjunction with the Programme
Service Identifier (PSI) packets.
The decoder uses the PID and PSI to identify the Programme Association tables (PAT).
PAT contain Program Map tables (PMT) that point the decoder to the packets associated with the channel or
programme such as video, audio and data content in the transport stream.

Type: Payload description
Description: PID description on a per stream basis

IPTV Map Table (Page 1) IPTV Map Table (Page 2)

IPTV Map Table (Page 3) IPTV Map Table (Page 4)
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MPEG-2 TS

A Packetized elementary stream (PES) is a continuous traffic stream of 188-byte packets
carrying the digital signal.
Since single/multiple programs can be carried per stream, a reference point from which the
STB can synchronize and start the actual decoding from, must be provided.
Each 188-byte packet consists of a 4-byte header containing this reference point which is a
PAT table and a PID value equal to 0.
The Packet Identifier (PID) contained within the 4-byte header, is a unique channel address
identifier allowing identification and reconstruction of the program. The PID is used in
conjunction with the Program Service Identifier (PSI) to identify Program Association Tables
(PAT) which in turn hold Program Map Tables (PMT).
The PAT table is also the table containing all program information ensuring the consumer
receives updated program changes. The PAT table lists all the programs in the transport
stream and associates each program with another PID that holds a Program Map Table
(PMT) as its payload.
PMT lists the video, audio and eventual encryption information. The Payload Structure
Identifier (PSI) table needs to be consistent with the PID table.
PAT and PMT are inserted into the stream so that the decoder performs correctly. These two
items should always be present.
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IPTV Scan

The scan results are as follows:

Channel - Displays channel number from the channel table
Zap time (ms) - Also known as inter-channel change delay. Time between a channel leave request is sent and the receipt
of the first byte of data from the new channel. It is the IGMP Join Latency + Channel Switch Delay (STB dependent).
Channel zapping should be < 700ms.
Status - OK, No Packet, Fail

Tap on the Channel field and select Unicast or Multicast Test. Press Start or Start All to initiate the Test(s).

IPTV Channel Scan IPTV Zapping Overview
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IGMP and Channel Zapping

IGMP is a signaling protocol that enables each STB to obtain only the programming that the
viewer is interested in watching, thus conserving bandwidth in the access network.
STBs use the IGMP to change channels, by leaving and joining multicast groups representing
channels.
Key to IPTV QoE, is how fast and reliably end users can change TV channels, also known as
"channel zapping".
Essentially it is calculated as the time taken between sending a channel leave request and
receiving the first video data of the new video stream.

Refer to DSL Forum TR-126 Triple Play Quality of Experience (QoE) requirements for
more info.

Go back to top Go back to TOC

IPTV Viewer

The IPTV Viewer displays the picture and is useful as a channel identifier.

Channel - Unicast or Multicast including IP address and UDP port #
Status - Decoding please wait. Please allow 20-30 seconds for buffering and decoding to occur.

Press Start to start the viewer. The Viewer lets the user view the video channel that is being streamed which is useful as a
channel identifier. The video stream will appear within 20-30 seconds depending on buffering and decoding time. The screen will
continue to refresh until Stop is pressed.

Note:

Only unencrypted streams can be viewed.
During the decoding stage, the Stop button will not be executed immediately.

The viewer supports the following codecs:

ISO 13818-2 Video = MPEG 2
ISO 14996-10 Video = H.264
ISO 14996-2 Video = MPEG 4
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IPTV Viewer

Physical Layer and IPTV Protocol Stack Troubleshooting Concept

Go back to top Go back to TOC
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5.1 IP Tools

IP Tools are also available on Ethernet test port.

Standard Functions:

Ping Test

Advanced IP Sofware Options:

Trace Route
WEB/FTP
ARP Wiz
VoIP
IPTV

Note: The Advanced IP software options need to be purchased in order to be accessible. If an Advanced IP software option is
not purchased and activated, the test set will pop up the "Option not enabled" dialog screen when attempting to access any of
those functions.

IP Tools Functions Hierarchy Diagram

IP Tools include test functions that require IP connection, which is established through one of the available wired or wireless
ports of the test set.

Before a Ping, Trace Route, WEB/FTP, ARP Wiz, VoIP, and IPTV test can be performed an IP connection needs to be
established.

See the Setup section for details.
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5.2 Net Wiz

Status
Discovery
Results

Go back to top Go back to TOC

5.2.1 Status

The Net Wiz function allows you to test the Ethernet cable and associated network environment. A typical application is shown
below:

Typical Net Wiz Application

Net Wiz Test functionalities include:

Cable Analysis with distance
to switch with MDI mode (Straight or Crossover)
to fault, type of fault (Open, Short, Impedance Mismatch)

Analyze the network and automatically report
Stations
Routers/Gateway
Printers

Provide MAC and IP addresses of each device
PING each device and verify the device is active
Provide detected networks (NetBiOS, IPX, etc)

Cable Test Setup

Press Start to begin the test.
The test set will return the connection type (Straight or Cross Over) if connected to an end device.
If a fault is detected (Open or Short) the fault will be indicated as well as the distance to the fault.
Press the small magnifying glass in the bottom right hand corner to more detailed test information.

Net Wiz Cable Test Cable Test - Detail Test Info
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5.2.2 Discovery

Discovery Setup

Before proceeding with the discovery function, please go to IP Tools to establish a connection.
Enter the desired IP address range in Begin IP and End IP using the alphanumeric keyboard.
Press on the desired tests and press Start.

Discovery

Go back to top Go back to TOC

5.2.3 Results

Summary tab reports:

Total transmitted and received frames
Received frames in error
Speed advertised
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Duplex mode advertised
Number of devices and networks found

Networks tab indicates:

Number of IP Subnets, Hosts, Domain, and Named Hosts Found.

Devices tab indicates:

Total number of devices found
Number of devices i.e. routers, servers or hosts.
Attribute of each device discovered including Ping test result.

Net Wiz - Discovery Summary Net Wiz - Devices Discovery (Page 1)

Net Wiz - Device Discovery (Page 10) Net Wiz - Networks Discovery
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5.3.1 WiFi InSSider

This function is currently available only on CX150+ units.

WiFi Menu
Conducting the test

Go back to top Go back to TOC

5.3.1.1 WiFi Menu

The WiFi Menu has the following options:

Client
AP Mode
SSID Viewer

WiFi Action Menu

Client: Same as the WiFi Wiz described in section 5.3.

Client Home
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AP Mode: Click Enable to configure the unit for AP Mode.

Note: AP Mode is not currently supported and thus should not be used.

AP Mode

SSID Viewer: WiFi InSSider Scan is conducted under this tab. By default the unit's screen displays this tab once connected to a
WiFi Adapter.

Go back to top Go back to TOC

5.3.1.2 Conducting the test

1. Follow the steps described in section 5.3 to setup the adapter for WiFi InSSider.

Note: The WiFi Adapter USB WIFI 802.11B/G/N 2.4G/5G TRANSCEIVER can also be used with this since it supports both 2.4G
and 5G spectrum.

2. Tap the WiFi Wiz tab under Tools menu. The screen will display messages that the unit is connecting to the USB Adapter.
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Connecting to USB Adapter

The WiFi InSSider supports 2.4GHz Channel and 5.0GHz Channel. The home screen has tabs to display test results for both
channels.

WiFi InSSider Home Screen

3. Tap Start to start the test.

After the scan is completed, the unit displays the number of access points (AP) detected for each channel of the 2.4GHz and
5GHz bands, and the strength of the strongest signal for each channel.

Tap the Graph tab of the respective Channel to view the results in a graphical presentation.

Scan Started
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5.0GHz Channel Graph View tab

The View tab brings circles on the screen. Tap one of these circles to navigate the bar graphs and bring additional information
about the AP.

SSiD: Tap on the SSiD tab after the scan is completed to view detailed information for each access point.

SSiD  
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Tapping on the selected SSiD opens the Graph tab.

Go back to top Go back to TOC
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5.3 WiFi Wiz

The function allows testing wireless WiFi 802.11b, 802.11n, and 802.11g networks. A typical application is shown below.

The WiFi Wiz function supports:

802.11b, 802.11g and 802.11n standards. Refer to WiFi USB adapter provided by VeEX.
WEP, WPA, WPA2 Encryption
Scanning
SSID broadcasting and report
Signal Strength
Mode (AP, IF) and Security
IP Connection and Ping Test

Setup

Plug the WiFi adapter into the USB port. Allow at least 30-45 seconds for the unit to detect the wireless adaptor and for
the software driver to load.
Products support USB wireless adaptors supplied by VeEX only and have the necessary software driver built into the test
set.
Tap on the pull down menu to turn the wireless USB adapter on. An information box will display the initiation process of
the USB and this process will take about 90 seconds.
Ensure the USB wireless adapter is connected before turning it on.

WiFi Adapter WiFi Setup - Activation

Procedure

Scan: Tap on the Scan tab once the test set has detected the wireless USB adapter. Press Scan on the bottom to start
scanning the site. When scan is completed, the test set will show the number of SSIDs, Channels, and the number of
SSiDs in Infrastructures mode and Ad-Hoc mode.
SSiD: Tap on the SSiD tab after the scan is completed. Select one of the SSiDs to start a connection. If the SSiD is
encrypted, a network key is required to complete the connection. The WiFi function supports WEP, WPA, and WPA2
encryption. The key can either be 10 characters or 26 characters.

Note: Choose manual selection to enter the parameters manually if the AP does not broadcast an SSiD that the
user would like to connect to.

Connect: Once connected, the connection screen will display the following information on the connection: SSiD, BSSiD,
Channel, Encryption, Type, Signal, and Link Quality.

Note: Signal and Link Quality are constantly updated so the value varies.
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WiFi Scan WiFi SSID Discovery

Note:

Depending on the distance between the Access Point and the test set, the signal might change. If the link quality is <
60%, the connection might drop. If the connection drops, the test set will automatically search for the connection and re-
connect. Therefore, make sure the connection is active (green WiFi icon on the top) before performing the Ping test.
After successfully connecting to the WiFi network, the user can go to the IP Tools Setup screen by tapping on the green

arrow and selecting the IP connect icon  to make an IP connection through the WiFi network.

WiFi Connection 
(Note green WiFi icon on top right corner) WiFi Menu

Signal versus Link Quality

Signal quality - The RSSI can be used as a measure of signal quality when there is no interference. But, in the
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case where the receiver experiences interference, the RSSI may falsely indicate sufficient signal strength even if
the desired signal is completely jammed by the interfering signal. This is because the RSSI cannot distinguish the
desired signal from the interfering signal. In this situation, a data integrity check can be used to detect if the
demodulated data is corrupted, and then subsequently adjust the transmit power. Using a CRC check as a
measure of link quality implies that a few bit errors occur in the data or voice transmission before the transmit
power can be increased. There is a lot of controversy about the term signal quality used in WLAN networks but the
most likely definition of “signal quality,” or “PN code correlation strength” is that it is some metric of the correlation
between the correct symbol-stream and the actual symbol-stream received. For example, the PHY might count the
average number of “wrong” bit positions over a window of some number of symbols, where zero “wrong” bit
positions equals 100% signal quality and more “wrong” bit positions results in lower signal quality.

Link quality - Fundamentally, the best way to measure link quality is to derive the Signal to Noise Ratio (SNR) of
the desired received signal. For that to happen, a demodulator in the receive chain needs to provide information
about the confidence of the detected symbol - also known as soft detection. However, with modern CMOS
transceivers used in WiFi type products, soft detection is not provided. Instead, in a typical application, there are
two measures of the Rx signal quality: Received Signal Strength Indication (RSSI) and integrity check of the
demodulated data by either Cyclic Redundancy Check (CRC) or PN code correlation strength.

Signal strength and RSSI - In reality, there are four units of measurements used to represent RF Signal Strength
namely mW (milliwatts), dBm (“dB”-milliwatts), RSSI (Received Signal Strength Indicator), and a percentage
measurement. Signal strength defined in the IEEE 802.11 recommendation for WiFi type devices is based on the
Received Signal Strength Indicator (RSSI) and is intended to be used as a ‘relative value’ within the WiFi chipset.
The 1-byte value can have values ranging from 0 to 255, but vendors prefer to use arbitrary scales from 0 to
RSSI_Max but in fact no vendor actually measures the 256 different signal level values so each adopts and uses
their own specific maximum RSSI value (RSSI_Max). For example on the WiFi adaptor we use, Linksys (Cisco)
chooses to measure 101 separate values for RF energy so their RSSI_Max is 100. Note that the RSSI value is not
associated with any particular power scale (e.g. mW) and it is also not required to be of any particular accuracy.
The RSSI value is used internally by the microcode in the adapter and by the device driver and this is why vendors
are not forced to use a compatible standard. As a result, the signal strength numbers reported by an 802.11 device
or adaptor will not be consistent between two vendors, and should not be assumed to be particularly accurate or
precise.

Go back to top Go back to TOC
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5.4 Cloning

Cloning enables the user to transfer profiles such as IPList, Channel Tables, Locations, Installation Check and Tilt from one test
set to another.

Use an Ethernet cable to connect the management port of the two test sets.

To access Cloning, go to the Tools page from the Home Menu.

Cloning - Controller Mode Cloning - Responder Mode

Cloning Setup

On the test set that is transferring the information, select Controller from the Mode drop-down menu. For the test set that
is receiving the information, select Responder from the Mode drop-down menu.
Note: Any pre-existing items on the responder unit will be overwritten.
Select from IPList, IPTV Channel Tables or Locations, Installation Check, Channel Tables, Tilt by tapping on the
corresponding box.
A message box confirming the transfer progress will appear in both test sets. A message will appear to confirm the end of
the cloning process.

Responder Receiving Profile Controller Transferring Profile
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Cloning Completed Message

Go back to top Go back to TOC
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5.5 ReVeal EZ Connect

The ReVeal EZ connect function turns the test set into a DHCP server to allow a PC configured as a DHCP client to establish IP
connection without changing the IP property setup for running ReVeal connection to the test set for result download, etc.

ReVeal EZ Connect

Before initiating ReVeal EZ, please make sure your PC is set for DHCP mode.
To begin, press the Start key. The unit will now act as a DHCP server (IP address = 192.168.0.1) Your PC (configured in
DHCP mode) will be able to acquire a leased DHCP address from the unit (in the IP address range 192.168.0.20x).

Note: When using ReVeal EZ Connect, ReVeal may not be able to detect the unit if the PC also has another IP connection, e.g.
WiFi, of different subnet active. You may need to temporarily disable the other IP connection.

Go back to top Go back to TOC
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5.6 Signature Pad

Note: This feature is currently only available on the V100+ series.

This feature enables a portion of the screen to be used as a signature pad and attach the signature to a test result linked by the
Job ID.
To begin, please make sure that the "Advanced Saving" Global Storage Setting feature is turned on. To turn on Advanced
Saving, go to Settings > System > Global > Saving > Advanced.

Advanced Saving Signature Pad

Press Clear to erase all changes from the signature pad.
Press Save to save the signature and fill out the Current Job ID, Current Account, Current Location, and Comments using the
alphanumeric keyboard. Locator and Type are set to none by default.

Go back to top Go back to TOC
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5.7 Data Card/GPS

Data Card is one way of connecting the test set to Internet. Data Card / GPS is an optional feature. The primary use of the Data
Card / GPS function is for connecting the test set to a ReVeal Server for workforce management and test results upload
applicable to the CX100/CX100+ series.

If the data card supports the GPS function, the test set will display the current location coordinates. With Advanced Management
option activated and when using with the ReVeal Server Productivity Suite application, the location of the test set will be shown
on the Map Users screen of the optional GPS Tracking function.

GPS Tracking

To establish an IP connection using a data card, insert the data card to the USB port of the test set. Wait until the circular 
icon is displayed at the top right corner of the screen after the test set successfully detects the data card. The color of the icon
indicates the status of the data connection and GPS location status. A red color indicates no IP connection or no GPS
information has been acquired. A green color indicates an IP connection or GPS information is available.

Home Menu
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Tap on the  icon to display the Data GPS information including the receive signal strength from the tower and also the local
coordinates.

Signal Strength and GPS Location

To access data card and GPS related setup function go to the Tools > Data Card/GPS menu. 

Tools Menu Data Card/GPS Setup
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Connection Mode - The default setting is On Demand. In On Demand mode, the IP connection will need to be
established manually. The test set will not perform connection retry if it fails.
GPS Refresh Rate - The interval for refreshing and updating the GPS information on screen. Selections are 15, 30, 60
and 120 seconds.

Go back to top Go back to TOC

Data Card/GPS Status 

Complementing the Data GPS screen, the Status screen shows additional information of the data connection and GPS
information as shown below.

Data Card/GPS Status

Go back to top Go back to TOC

Making an IP connection
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To establish an IP connection through the data card go to Tools > IP Tools > Setup menu. After test set successfully detects a
data card installed, it will set the connection Mode to Data Card automatically. Select the Service Provider as appropriate or use
Custom to enter the APN, Username and Password information if needed. Tap on Connect button to initiate an IP connection
attempt.

Service Provider Network Setup

Once the connection has been established, the IP address will be displayed on the second line of the screen and the test set will

switch to display the Status screen. The upper portion of the  icon will turn green. There is also a green  icon on the first
line of the screen.

Status

To terminate an IP connection through the data card, tap on the Disconnect button at the bottom of the IP Tools Setup or Status
screen.
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6.0 Settings
About
Bluetooth
Screen
Power
Global
Self Test
Date & Time
Network

Go back to TOC

6.1 About

Displays Serial #, MAC address and other properties of the test set including software options.

Settings Menu About Menu
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6.2 Bluetooth

The V100+ product series supports a micro USB Bluetooth adaptor offering wireless connectivity up to 10 meters (30 feet). Ultra
compact and portable, the adaptor provides an untethered connection between the tester and other Bluetooth compatible devices
such as a Notebook PC or cell phone, so the user can transfer test result files quickly and easily without having to hassle with
memory sticks or Ethernet connections.

A Bluetooth connection serves two purposes. In a PC connection, the test set is able to transfer test results. In a mobile phone
connection, the test set can form a Bluetooth Dial-up IP connection.

An overview of the application is shown below.
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Bluetooth Adaptors - Compatibility

Not all Bluetooth adaptors on the market are supported by the V100+ product series. Please use
adaptors that have been tested and supplied by VeEX only to ensure compatibility and correct
operation.

Bluetooth Setup

Turn on the Bluetooth radio on the device you wish to connect with the V100+ test set. Insert the Bluetooth adaptor into the USB
port on the side of test set. If you are using more than one USB device, use an external USB hub to connect additional devices.

Once detected, a Bluetooth icon  is displayed on screen.

Scan
The V100+ series will automatically detect the Bluetooth adaptor once plugged into the USB port. Details of the Bluetooth adaptor
will be displayed including the MAC address of the device and the last 4 digits of the serial # of the V100+ test set. The last 4
digits of the V100+ series test set will be the pairing code between the unit and the external device.

Devices
Please ensure the peripheral device is set to "Discoverable" during Scanning and Pairing operations. Once scanning is complete,
a list of discovered Bluetooth devices will be listed.

Bluetooth Scan Menu Bluetooth Devices Menu
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During the pairing operation, you will be prompted to enter a code on the peripheral device (PC or Mobile Phone) in order to pair
successfully. Enter the last 4 digits of the V100+ serial number which is displayed in the Name field - see Scan mode above.
Once paired, click the services button at the bottom of the screen to check the service attributes. To upload test results via
Bluetooth and Mobile phone to a UMTS or 3G network, full data upload service will be required.

Bluetooth Scan Info Bluetooth Services Message

Transferring Test Results and IP Connection

After establishing a Bluetooth connection, the user can:

transfer test results from the test set to a peripheral device (see 7.0 Files section Bluetooth Transfer Mode).
establish an IP connection with a mobile phone (see 5.1.1 IP Setup sections BT Dial-up Setup and BT PAN Setup).
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6.3 Screen

This feature allows the user to calibrate the touch screen when the alignment is off. There are 5 alignment points starting from
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the center of the screen. To access this feature, go to Home Menu > Settings > Screen. Carefully tap on the alignment point
using the stylus.

Screen Alignment
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6.4 Power

Power - Displays the power source detected and the remaining battery charge if running on battery. An Auto-off timer facility is
also provided to conserve battery life.

Power Menu - AC Power Power Menu - Battery Life
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6.5 Global Settings

The following parameters can be adjusted in the Global Settings menu:

Language - Several languages supported including English, German, etc. depending on Geographic distribution.
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Units - Metric and English
Show Password - Hides sensitive passwords during FTP and other operations
Management Port - Remote Control or IPTV mode

Remote control - Select if unit will be used for remote control
IPTV - Select when unit is to be used for IPTV STB applications

Saving - Automatic or Advanced
Automatic - Unit automatically saves test result with default File name prefix and Tech ID information
Advanced - Unit prompts user for Job ID, Account #, Location and other job related comments (see screen below)
File Name Prefix - A user defined prefix can be set for test rest saving operations
Tech ID - A user defined Identity can be set for test result saving operations
Tech Name - Technician can insert his/her name.
Company name - User defined field for Company name

Global Settings Menu Advanced Saving
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6.6 Self Test

Feature not yet available.
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6.7 Date and Time

During initial setup, please enter the Time and Date information correctly. This TOD information is used to time stamp test results
and measurement event logs so it is important to set this parameter correctly prior to using the test set to make measurements.

Time Zone

Setting the Time Zone will automatically update the test set during daylight savings and other time zone changes.

Date & Time Menu Time Zone Menu
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6.8 Network

Please go to IP tools to set up the network.
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7.0 Files
The V100+ saves the Files (Test Results) in the unit's internal memory for recall and viewing. They are accessed through the
Files function from the Home screen.

Saving Files
Recalling or Viewing Files
File Transfer

FTP
USB Transfer
Bluetooth

R-Server
ReVeal Manage Files
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7.1 Saving Files (Test Results)

Press the File button on the rubber keypad.
The Test Result from the active Test Application is saved in non-volatile memory
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7.2 Recalling or Viewing Files or Test Results

There are up to four tabs namely Capacity, Explorer, Transfer and R-Server available in the Files function. R-Server tab is
only available when Advanced Management option is activated on the test set.

Capacity
Used space shows the % of capacity occupied by saved test results
Free Space indicates the spare capacity for results storage

Explorer - Displays the test result files and the type of test result stored. Tap to select the result file and use the soft keys
at the bottom of the screen to perform the desired operation on the selected result file.

File Capacity Menu File Explorer

View - To open and view the result file
Del - To delete the result file
Rename - This will bring up the soft keypad for changing the existing file name of the result file.
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U/L - Toggle between lock and unlock. To protect a result file from accidentally being deleted, use the U/L soft key
to lock the file. The folder symbol associated with the result file will be changed to as shown in the following
screen shot.
Job - This is a display filter to list result files of specific Job ID and Location combinations. See the Global Settings
Advanced Saving section of this manual for Job ID and Location entry when saving test results.
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7.3 File Transfer

The test result files are saved in a proprietary format. The transfer function allows the user to copy the selected result file(s) from
the test set to either:

An FTP Server for centralized storage
A USB flash memory drive for further distribution of the result file.
A PC through Bluetooth connection.
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7.3.1 FTP Transfer Mode

Transfer Mode - Set the mode to FTP to transfer result file to a FTP server
FTP Address - Enter the IP address of the FTP server using the soft keypad
File/Path - Enter the subdirectory under the root (or home) directory associated with the FTP server user account where
the result file will be transferred to.
User - The user name of the FTP server user account. The user account must have write access privilege to the FTP
server.
Pwd - The associated password of the user account

FTP Transfer Mode

Select the result files by tapping on the check box of the file. Tap on either the Upload or CSV Upload to start uploading the
result file(s).

Upload - Transfer the raw data file of the selected result to the FTP server. The raw data can only be read using the
appropriate ReVeal PC software.
CSV Upload - Upload the selected result in CSV file format only to the FTP server.

After the transfer has been initiated a message box will display the progress of the transfer.

File Upload - In Progress File Transfer - Finished
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To abort a result file transfer, tap OK. Otherwise, wait until the upload is completed (when the message Upload finished is
displayed). Tap on Reset to return to the Transfer selection screen.
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7.3.2 USB Transfer Mode

To transfer a result file to a USB flash memory drive, insert the drive to the USB port of the test set. 
As soon as the Transfer Mode is set to USB, the test set will detect the USB flash memory drive and a message box indicating
USB detection will appear.

USB Transfer Mode Detecting USB Storage

Select the result file(s) to be transferred to the USB storage device then tap on Transfer to initiate the file transfer. A folder
containing the result data, with the file name prefix defined in the Global Settings menu and the name of the selected result file
will be created on the attached storage device. For example, if the file name prefix is Filestr and the name of the selected result
file is 7, the created folder name on the storage device becomes Filestr7.
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The test set will display the Transfer finished message when the transfer is done. Tap on Reset to return to the USB transfer
setup screen.

Transfer In Progress Transfer Finished

Unloading USB Storage

When all result file transfers are finished, tap on any of the other tabs, e.g. Explorer tab, to unload the USB storage device.
Remove the device from the USB port of the test set. If this is not performed, the file transferred may be lost.
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7.3.3 Bluetooth Transfer Mode

After securing a Bluetooth connection, Bluetooth transfer mode enables a V100+ test set to to transfer test results to a PC. For
more details on setting up a Bluetooth connection, see section 6.2 Bluetooth.

Hit Transfer. A message will appear on the test set and peripheral device prompting the user to accept or decline the connection.
Hit Ok for the message on both screens to initiate the connection. Transferred files will be compressed to .tar.gz archive format
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which can be uncompressed using a file extracting program.

BT File Transfer Access Authorization on PC
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7.4 R-Server

To enter the R-Server result upload function, there must be an IP connection established, otherwise a reminder message will pop
up.

A test set must register to an R-Server before it can upload results to the server. The screen shot on the far left shows that a
unit has been registered to the R-Server with the name Test Center at the specified IP address after performing a Check status
operation.

R-Server Registration R-Server Upload Status

To upload result files to the R-Server, tap the Upload tab and select the desired files. Tap on Upload or Upload&Del.
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Upload - Transfer the selected result file(s) and keep the file(s) in the test set.
Upload&Del - Delete the file(s) from the test set after uploading.
Job - This is a display filter to list result files of specific Job ID and Location combination. See the Global Settings
Advanced Saving section of this menu for Job ID and Location entry when saving test results.

Move to the Download tab to download profiles from the connected R-Server. The Download tab flashes red when the test set
detects any discrepancy in profiles and software version between the test set and the R-Server.

R-Server Download Status

Tap on Download to initiate profile download to synchronize the profiles to the server. When the download is completed, the test
set will reboot to take the new profiles into effect. When profiles are downloaded and transferred to the test set, all existing
profiles previously stored on the test set will be deleted and replaced. 

For Workforce function please refer to R-Server related documentation.
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7.5 ReVeal Manage Files

ReVeal Software can be used to manage the files transferred onto the USB storage device or to the PC. Please refer to the
relevant ReVeal software user's manual for additional information.

From the ReVeal home page select Results.
From the Results menu select Manage Results.
Select "Add to add new files" to the Manage Results.
Select the device where the files are stored.
Select one of the files from the USB storage device to add to Manage Results.
The name of the file will be displayed when the file is added to the Manage Results. The user can rename, delete, and
open the files that are in Manage Results.

ReVeal MTX Home Page
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8.0 Help
A short form version of this User Manual is embedded in the firmware of this test set. The Help menu contains all the User and
Technical information presented in this User Manual with the exception of graphics and tables.

Click on the link in the Help menu to access the topic or chapter of interest. The links or bookmarks in the Help menu
correspond to the Table of Contents at the beginning of this document.

Help Menu Help Contents
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9.0 Backlight
The backlight settings for the LCD touch screen are accessed via the Backlight menu.

Battery Power - Backlight settings when test set is operating from built-in Li-ion battery.
A short backlight time is recommended to extend battery operation time

AC Power - Backlight settings when test set is operating from AC mains Voltage
Longer backlight times can be set when operating from AC power depending on user requirement

Brightness - Brightness level when operating on Battery or AC power

Backlight Backlight Battery Power

Backlight AC Power Backlight Brightness
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